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1 MonitorTm Help Manual

1.1 Overview

MonitorTm is the Transfer Module program used to communicate with FAST Monitor
 allowing the user to

· Synchronize data with the Aircraft

· Synchronize data with Webserver

· View Monitor Status

· View Live Data

· View/Change Monitor Parameters

· Configure the FAST Monitor

· Retrieve Log Files

· Convert Log File Data  for analysis using GBSLite

· Retrieve Micro-Server logs

· Reset FAST box to factory

1.2 Export Classification

The MonitorTM software export classification is as per the following:

1.3 What's New

What’s new in MonitorTM Version 3.8
- ATR42/72 exceedances detection updated.
- TBM910/930 new Garmin versions supported (20.51, 20.87 and 20.85).
- King Air B200/B300 Full flight data processing supported.
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- Pilatus PC12-47E Full flight data processing supported.

What’s new in MonitorTM Version 3.7
- View/Change parameters function: current value display corrected.

What’s new in MonitorTM Version 3.6
- Q400 EMU converter 1505HI detection updated.

What’s new in MonitorTM Version 3.5
- Updated MonitorTM functions for MFAST (HTTP protocol).
- Support AW139 V6 configuration.
- Support Q200/Q300 with additional propeller Overtorque Events.
- Updated Q400 EMU converter for 1505HI event detection.
- Support FAST full flight data processing for King Air B200/B300.
- Support FAST full flight data processing for Pilatus PC12-47E.
 
What’s new in MonitorTM Version 3.4
- Application updated to restore 32 bit operation systems compatibility (All
functionalities except "Convert log" function)
- Updated event detection for Q200/Q300 and M600

What’s new in MonitorTM Version 3.3
- Updated Q200/Q300 exceedances, trace and snapshot capture 
- Improved Mission enhancements  and filtering Q200/Q300.
- Support enhanced mission and filtering for Daher
- Updated filtering logic for ATR42/72
- Updated AW139 Exceedance and Fault detection
- Updated filtering logic for Q400
- Updated filtering logic for CARAVAN
- Updated trend filtering logic for F7X
- Updated trend filtering logic for F8X
- Support FAST for PIPER .
- Support Test Monitor Transmission  for EPECS
- Support Wi-Fi Configuration  EPECS
- In service issue adressed

What’s new in MonitorTM Version 3.2
- Support FAST for Daher TBM .
- Upgrade MonitorTM compatibility with new SFTP Server
- New feature to change Daher A/C serial Number
- In service issue addressed
- Support Configure Unit for EPECS

What’s new in MonitorTM Version 3.1
- Support MFAST for EPECS.
- Support FAST for ATR42/72 FDAU V3.
- New feature to manually check for Monitor TM version upgrade
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- Application upgrade for 64 bit support and Tablet Windows 8 Pro.

What’s new in MonitorTM Version 3.0
- Support FAST for ATR PBMS and RSN.
- Support FAST for ATR42/72 FDAU V2b.
- Support FAST for King Air B200/B300.

What’s new in MonitorTM Version 2.9
- Support FAST for ATR Propeller Balance.
- Support FAST for King Air B200/B300 and generic ETM conversion
- Support MicroFAST Full Flight Data Conversion 
- Support Q400 and ATR42/72 OOOI events
- PW150A EMU converter updated : missing traces extracted

What’s new in MonitorTM Version 2.8
- Latitude conversion issues addressed
- Windows 10 compatibility 

What’s new in MonitorTM Version 2.7
- Support FAST for Dassault Falcon 8X conversion.
- Support FAST for Cessna Latitude 680A Phase 2 (enhanced cruise monitoring)
- Support FAST for AW139 Phase 2 (APAC)
- Support FAST for Q400 propeller vibration monitoring 
- Support enhanced filtering of Q400 trend events
- Wi-Fi Configuration  for data offload 
- Improved View Live Data  performance
- Improved communication for FAST Monitor communication.

What’s new in MonitorTM Version 2.6
- In service issues addressed.

What’s new in MonitorTM Version 2.5
- Support FAST for Cessna Latitude 680A EDU conversion.
- Support enhanced filtering of Caravan trend events
- Support new FOQA cleaning process
- Improved GUI performance, especially for Windows 8.1.

What’s new in MonitorTM Version 2.4
- ATR42/72 conversion update for ARINC label decoding

What’s new in MonitorTM Version 2.3
- Support FAST for AW139
- Support FAST for Q400 Phase 2 (1505HI, MTOP Monitoring, etc.)
- Enhanced Retrieve Log Files Function .

What’s new in MonitorTM Version 2.2
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- Support FAST for ATR42/72 aircraft.
- New "Delete Non-Transmitted Logs" password protected function.

What’s new in MonitorTM Version 2.1
- Enhancements to Q400 data conversion.
- Improved communication for configuring the FAST Monitor.
- Full flight data conversion options simplified.

What’s new in MonitorTM Version 2.0
- New drivers to support Windows 8.
- New “FAST Factory Reset”  function.
- New “Get Micro Server Logs”  function.
- Improved Sync to Aircraft.
- Improved data conversion.

What’s new in MonitorTm Version 1.8
- Support for Cessna Caravan aircraft: 
New “Retrieve Log Files” interface, New ‘’View/change Monitor Parameter” interface
to display Engine/Flight cycles and creep information.
- Improved test monitor transmission function.

What's new in MonitorTm Version 1.7
- Data conversion function for Q300 application timestamp fixed.

What's new in MonitorTm Version 1.6
- Data conversion function for Q300 application
- Preference  "Tag Data Transmitted" is not ON by default.
- Successful data conversion of files with multiple legs (error codes 17 and 18)

What's new in MonitorTm Version 1.5
- Data conversion function for Q400 EMU and QAR files
- Support of new FAST embedded software v1.1.0
- Improve Convert Log function user interface for more flexibility

What's new in MonitorTm Version 1.3
- Data conversion function improved for LJ60 application
- Data conversion performace improved

What's new in MonitorTm Version 1.1
- Windows 7 32-bit and 64-bit support
- Updated communications to monitor
- Updated user messages
- Removed transparent function
- Added View/Change Monitor Parameters  function
- Updated F7X event list
- Updated synchronization procedure to synchronize to Webserver
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What's new in MonitorTm Version 1.0
First release of the program including the following functions:
- Synchronize data with the Aircraft
- Synchronize data with WebECTM
- View Monitor Status
- View Live Data
- Configure the FAST Monitor
- Retrieve Log Files
- Convert Log File Data  foranalysis using GBSLite
- Support for F7X aircraft
- Support for LJ60 aircraft

1.4 Hardware Requirements

Communicating with Monitor Functions
- For FAST Monitor, connection via GSE USB cable on J3 connector
- For MFAST Monitor, connection via GSE USB cable on J2 connector (USB mini-B)

FAST Monitor Radio frequency radiation exposure Information:

“This device complies with part 15 of the FCC Rules. Operation is subject to the following two

conditions: (1) This device may not cause harmful interference, and (2) this device must

accept any interference received, including interference that may cause undesired operation”.  

“Changes or modifications not expressly approved by the Pratt & Whitney Engine Services

could void the user's authority to operate the equipment”

“The integrated radio modules [IC: 7830A-PLS62W & IC: 5969A-TIWI101] on this device  has

been approved by Innovation, Science and Economic Development Canada to operate with

the antenna types listed below, with the maximum permissible gain indicated. Antenna types

not included in this list that have a gain greater than the maximum gain indicated for any type

listed are strictly prohibited for use with this device.” 

WiFi antenna: Single element, 50 ohms, vertical/omnidirectional, RPSMA,  Dipole, Freq Rng:

2.4-2.5GHz, 1.5dB gain @ 2.4GHz or equal.

Cellular antenna: Single element, 50 ohms, Linear, omnidirectional, SMA, VSWR:2.1, 

Frequency range/Gain: 698-960MHz 1.5dB, 1710-2170MHz 3.0dB,  2500-2700 4.5dB  or

equal.

To comply with FCC  rule parts 2.1091 /  ISED RSS 102  RF exposure requirements for

mobile transmitting devices, this device and  the antenna(s) used for this transmitter must be

installed to provide a separation distance of at least 30 cm ( ~ 12 inches) from all persons

(and must not be co-located or operating in conjunction with any other antenna or transmitter.
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1.5 Software Requirements

All Installations:
- Windows 7, Windows 8, Windows 8.1, Windows 8.1 Pro or Windows 10
- Windows 64bit operation systems (All functionalities)
- Windows 32bit operation systems (All functionalities except "Convert log"
function) 
- Microsoft Internet Explorer 6.0 or above
- PDF Reader

Tablet Installations:
-  Windows 8 Pro 64bits

Communicating with Webserver
- Internet Access

Optional:
-GBSLite Diagnostic Module for data analysis on PC

1.6 Program Installation

Initial Installation
To install MonitorTm for the first time, launch the set-up program and follow
instructions.

The default location for installation is C:\GBS-PWC however; when GBSLite is
already installed on the PC, the default installation location will automatically be
configured to the GBSLite installation directory.  If GBSLite is to be installed after
MonitorTm is installed, it should be installed in the same location as MonitorTm

Automatic Updates
When the program starts, it verifies if there is a new version available.  If an update
exists, the program will indicate that an update is available and to perform Monitor
TM Auto-Update  in the Help Menu .

Whenever MonitorTM synchronizes with the Web and an update is available, the
user will be prompted to download the new version.  If the user selects to download
the new version, it will be installed at next program startup with user required to
follow on screen instructions
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A shortcut will be installed on the desktop

1.7 Program Version

Accessing:

Program version information displayed
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1.8 Printing a hard copy of manual

Accessing:

Upon selection, the PDF Help Manual will be displayed

Adobe Acrobat is required.  See Software Requirements  for details11
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2 Accessing MonitorTm Functions

2.1 Starting and Closing the Program

To start the MonitorTm program, double click on the MonitorTm desktop icon

To close the MonitorTm program use  or

   

2.2 Main Program View

Functions in the MonitorTm Main Program View can be accessed in two
different ways

The Side Bar: Large buttons with the most commonly used functions
Sync to Webserver , Sync To Aircraft , Monitor Status , Live Data , Test
Monitor Transmission .
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The Menu Bars: contain side bar functions as well as other functions

The File Menu has the following functions available:
Print ,Print Preview , Print Setup , Exit

The View Menu has the following functions available:
Session Log , Saved Monitor Status , Preferences , View Data in GBSLite

The Monitor Menu has the following functions available:
Sync to Webserver , Sync to Aircraft , Monitor Status , Live Data , View/
Change Parameters , Configure Unit , Retrieve Log Files

The Expert Menu has the following functions available:
Communication Settings , Expert Command Mode , Convert Log , Test
Monitor Transmission , Get Micro Server Logs ,FAST Factory Reset
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The Help Menu has the following functions available:
About Monitor , Monitor TM Auto-Update  , Help Manual12 60 13
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Functions are always performed in the main area

Communication settings and status messages are always displayed in the
lower area

When connected to the monitor, a photo of the monitor is displayed
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3 Communicating with the Monitor

3.1 Sync to Aircraft Function

Accessing:

  

The Sync to Aircraft function is used to download log files from the monitor to the pc
and to upload configuration files from the pc to the monitor

This function automatically performs the following 2 functions
1. Retrieve Log Files Function
2. Configure Unit Function

Refer to individual function descriptions for further details

3.2 Retrieve Log Files Function

Accessing:

This function retrieves log files from the monitor for the purpose of analyzing the
data locally on the computer or to transfer data to the P&WC Web server.

The files to be retrieved can be selected by the user and download time is indicated.
 The column header check box  can be used to select all log files.

When the estimated retrieval time is less than a configurable limit, all files will be
retrieved without requiring user selection.  Refer to Changing MonitorTm
Preferences  for details

By default, retrieving logs from the monitor does not modify their transmitted status
in the monitor (i.e. the monitor will still upload them to the web via GSM cellular). 
Refer to Changing MonitorTm Preferences  for details
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For the Caravan application and all FAST serial number 45xxxx, the user can either
retrieve transmitted or not transmitted log files for ETM and Full Flight data files. See
the screenshot below:

For other applications, the user can either retrieve transmitted or non transmitted log
files. Draf

t
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After selection, the user can check boxes of desired files to be retrieved and click
the start button to start the process. A retrieve progress status will be shown.

For FAST system containing Micro Server Software version 2.9 or higher (refer to
PW_VER field in the Monitor Status Function ), the download time is reduced
when all log files are selected for download.

To retrieve all log files, select the checkbox on the top left in the Log File Selection

25
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screen. The download process will be displayed in seconds.

Note: MonitorTM download all files packaged in a TAR format using Open Source
Software Windows TAR library where distribution is managed by license terms as
per link http://creativecommons.org/licenses/by-sa/3.0/legalcode

3.3 Configure Unit Function

Accessing:

This function is used to reconfigure the monitor settings when they need to be
modified

This function uploads configuration files from the computer to the monitor

Configuration file versions in the monitor are compared with configuration file
versions on the computer

When the configuration file versions on the computer are more recent than those in
the monitor, the program will proceed with the configuration of the monitor
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When the configuration file versions on the computer are the same or older than
those in the monitor, the user must choose to proceed with the configuration of the
monitor.

After the files are uploaded into the monitor, the monitor will reboot.  This should take
approximately 1 minute.
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3.4 Monitor Status Function

Accessing:

  
This function provides an overview of the status of the monitor and the status is
updated continuously as long as the function is selected. 

The status can be saved to an xml file or printed via File>Menu/Print.

The saved status can be viewed via the View Saved Monitor Status Function

The following are the possible status messages that can be seen as well as
recommended actions to take

Displayed Name Description
Serial Number FAST Box serial number
Time FAST Box time of day
Source of Time Source that FAST syncs to for time of day clock

LOCAL : Time is synchronized to the FAST box

REMOTE : Time is synchronized to the EEC (Electronic Engine

Controller)
Note: This option is not available on all applications

MS : Time is synchronized to the ground server

CP Software VersionThe CP (Control Processor) software version
CP CRC The CP (Control Processor) software CRC (Cyclic Redundancy

Check)

64
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Install ID Installation ID field of the FAST Box from the loaded configuration
Configuration
Version

The loaded configuration version

Number of Box Power
On

The total cumulative number of times the box has been powered on

Number of Box Power
On In Seconds

The total cumulative number of seconds the box has been powered
on

PW_VER Micro server software version
Aircraft Tail
Number

The aircraft tail number field stored in the configuration

Aircraft Operator The aircraft operator field stored in the configuration
Aircraft Owner The aircraft owner field stored in the configuration
# of Logs in MemoryThe total number of logs in memory that are pending upload to the

Micro-Server Compact Flash
% of Log Memory
Used

The percentage of log memory used

UNTXD_FILES Number of non transmitted files
Box System
Condition

The box system condition
NORMAL

CAUTION
FAULT

If fault or caution status, please perform the Expert Commands
function  : Recent Faults to obtain a list of the last 10 faults and
call P&WC Customer First Center.

If the problem persists, download system logs using Retrieve Log
Files function

Communication
Between MS and CP

Indicates if communication between the Micro-Server processor
and Control processor is running

YES : Communication between Micro-Server Processor and

Control Processor is running

NO : not necessarily a problem and can occur during a box

power up
- Try closing the function, wait 2 minutes; and then retry the
Monitor Status function
- If NO still displayed, call P&WC Customer First Center

3.5 Test Monitor Transmission Function for FAST

Accessing:

  

42

20Draf
t



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

27Communicating with the Monitor

© 2019 Pratt & Whitney Canada Inc

This function verifies that the monitor can transmit data to the Web server
successfully 

The following are the possible test status messages that can be seen as well as
recommended actions to take

Displayed
Name

Possible
Values

Description Recommended Action

System
Condition

blank System Condition
verification is not yet
complete

PASS System Condition is OK
FAIL System Condition is FAULT

and cannot transmit through
GSM

Please perform the Expert
Commands function  : Recent
Faults to obtain a list of the last 10
faults and call P&WC Customer
First Center

Weight On
Wheels
Condition

blank Weight on Wheels
verification is not yet
complete

PASS WOW discrete input is
TRUE

FAIL WOW discrete input is
FALSE and GSM cannot be
enabled

Verify the resistance between J1
(harness connector) pin 15 and pin
2 or 3. At least one of them should
be < 100 ohm.

On Ground
Trigger

blank On ground criteria
verification is not yet
complete

PASS On ground criteria is being
met
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FAIL On ground criteria is not
being met and GSM cannot
be enabled

1. Ensure engines are off and wait 2
minutes
2. Repeat Test Monitor
transmission.  If FAIL remains,
perform Live Data Function  to
verify validity of parameters. If any
parameters are invalid, correct the
problem.
3. Repeat Test Monitor
transmission.  If FAIL remains,
perform Expert Command function

 : show config and save/send to
P&WC Customer First Center for
review of show config and live data
parameter values from step 2

Record Data
Trigger

blank Configurable data record
triggers verification is not
yet complete

PASS Configurable data record
triggers are inactive. FAST
is not recording data

FAIL Configurable data record
triggers are active. FAST
cannot upload log data
while recording

1. Ensure engines are off and wait 2
minutes
2. Repeat Test Monitor
transmission. If FAIL remains,
perform Live Data Function  to
verify validity of parameters. If any
parameters are invalid, correct the
problem.
3. Repeat Test Monitor
Transmission.  If FAIL remains,
perform Expert Command function

: show config and save/send to
P&WC Customer First Center for
review of show config and live data
parameter values from step 2

Micro Server
Ready

blank Micro-Server interface
verification is not yet
complete

InProgress
##% 

FAST waiting for Micro-
Server interface to become
ready.  This can be
displayed for up to 2
minutes

PASS Micro-Server interface is
ready for use

FAIL Micro-Server interface is not
ready for use

Repeat test one more time.  If the
test fails again, perform Expert
Command function  : Micro-Server
Status and contact P&WC for

33
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support

GSM Sim Card blank GSM SIM card verification
is not yet complete

InProgress
##% 

FAST waiting to detect and
read the SIM card.  This
can be displayed for up to 3
minutes

PASS SIM card is detected and
card ID detected

FAIL FAST not able to read the
SIM card ID

1. Verify that the SIM card is
installed properly, cycle box power
2. Repeat Test Monitor
Transmission function.  If FAIL
remains, remove and re-insert the
SIM card, cycle box power.
3. Repeat Test Monitor
Transmission function.  If FAIL
remains, remove SIM card and test
in a cellular phone of the same
network provider (i.e. AT&T, Rogers,
or unlocked, ...)
4. Repeat Test Monitor
Transmission function.  If FAIL
remains, contact P&WC Customer
First Center for further support

GSM Signal blank GSM signal strength
verification is not yet
complete

InProgress
##% 

FAST waiting to connect to
a GSM network.  This can
be displayed for up to 5
minutes

PASS -
###dB 

FAST can connect to GSM
network.  Signal Strength
displayed (dB)

Preferred to see -95db or greater (i.
e. -60 is good). Try relocating
aircraft if signal strength is poor (i.e.
out of hangar, or different airport)
and repeat Test Monitor
Transmission function.

FAIL FAST was unable to
connect to a GSM network
within the expected time

1. Verify the account is active with
network provider (i.e. AT&T, Rogers,
etc..)
2. Repeat Test Monitor
Transmission function.  If FAIL
remains verify you are in cellular
range by removing SIM card and
testing in a cellular phone of the
same network provider. (need to
cycle box power after reinserting in
FAST box)
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3. When in cellular range, repeat
Test Monitor Transmission function,
verify antenna is connected to FAST
box (GSM connector)
4. When antenna is connected,
repeat Test Monitor Transmission
function.  If FAIL remains, contact
P&WC Customer First Center for
further support

VPN
Connection

blank VPN Connection verification
is not yet complete

InProgress
##% 

FAST waiting to establish
VPN connection to ground
server.  This can be
displayed for up to 5
minutes

PASS FAST established VPN
connection to the ground
server

FAIL FAST unable to establish
VPN connection to ground
server within expected time

1. Verify that a data plan is
activated with the cellular network
provider.  If no data plan, activate
data plan and repeat Test Monitor
Transmission function.
2. If FAIL remains, verify GSM using
GSM Signal Strength indication
above (i.e. PASS -###dB).  If GSM
Signal Strength is too low, try to
correct the problem and repeat Test
Monitor Transmission function.
3. If FAIL remains, contact P&WC
Customer First Center for further
support

Upload
Status

blank Upload Status verification is
not yet complete

MoveLogsT
oMS 

FAST is moving log data
from control processor to
Micro-Server

If this message is seen for more
than 5 minutes:
1. Perform Expert Command
function  : Verbosity Normal to
see messages
2. If messages beginning with
"Upload" seen, wait for completion.
Perform Expert Command function

 : Verbosity Off and repeat Test
Monitor Transmission function.
3. If this status is seen for more
than 5 minutes again, or if no
messages beginning with "Upload"
seen, contact P&WC Customer
First Center for support

42
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MoveLogsT
oGround ##
% 

FAST is moving logs from
Micro-Server to Ground via
GSM

If number is incrementing, wait for
completion
If number is not incrementing after a
few minutes, contact P&WC
Customer First Center for support

PASS FAST has moved all log
files to ground server and
verified

Test Monitor
Transmission
Status

This Is The Final Overall Status of the Test Monitor Transmission
function
Stopped There has been no test

activity since the last
power-on

Cycle box power and repeat Test
Monitor Transmission Function

InProgress running each step to verify
log transmission to ground
server

PASS Test completed and
successfully transmitted
data to the ground

Fail:
<FailReas
on> 

Test stopped because one
of the above statuses has
failed

3.6 Test Monitor Transmission Function for MFAST

Accessing:

  

This function verifies that the monitor can transmit data to the Web server
successfully by using one of the two options
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Function using Cellular

Function using WI-FI
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3.7 Live Data Function

Accessing:

  
The Live Data function allows the user to view and record live data from the
monitor's available data sensors.

The user must select the sensors to display using check boxes.  The column
header check box  can be used to select all sensors.

Click Retrieve Selected to proceed

The values and units of selected sensors are displayed.

Any invalid sensors are displayed in red.

Start and Stop Recording buttons permit recording a sequence of live data.

Refer to the Analyzing Data section for analysis 
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3.8 Communication Settings Function

3.8.1 Accessing

The Communication Settings Function can be used for detecting and
troubleshooting connection settings and contains two options.  For troubleshooting
guidelines, refer to Communication Troubleshooting

3.8.2 Auto-Detection

Automatically detects the Connection Type connected to the monitor by screening
the available COM ports. Performed automatically prior to each function requiring
communication with the Monitor.

65
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3.8.3 Manual detection

· Find the com port via Device Manager

· Disconnect FAST USB cable and  Expand the Ports menu  .
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· Connect the FAST USB cable,  the Ports will automatically update

Note: If the RS-485 Port (COMX) is not displayed, USB driver is not properly installed, please
refer to FAST USB GSE Cable Driver Installation .

· Open Monitor TM 

· Under Expert , select Communication Settings

· From Connection Type scrolling menu select the com port found previously (i.e :

COM6)
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· Click on  

Communication settings are displayed in the Monitor Type, COM Port and Baud
Rate fields.

Communication status is displayed in the Message field

3.9 View/Change Monitor Parameters

Accessing:

The View/Change Parameters function can be used to change parameters in your
monitor.

3.9.1 View/Change Monitor Parameters for ATR42/ATR72 application

For ATR42/72 and AW139 applications, the function enables the user to view/
change the fast box time and enter the engine serial number information.  For
ATR42/72 only, the user can also clear the engine serial number the engine serial
number is available via the ARINC 429 data.
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View/change FAST box time and engine serial number information

After you enter the new values, select the write button.

The new parameters values will be updated in the monitor and the Current Value
column will be refreshed. Verify the current values are appropriately refreshed
before closing.

Click "Proceed" to clear the engine serial numbers stored in the FAST box. 
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3.9.2 View/Change Monitor Parameters for CARAVAN application

For Caravan application, the function enables the user to view/change the fast box
time, engine serial number, flight/engine cycles and creep information.  The user
can also reset creep faults and CAS Previous Exceed messages.

View/change FAST box time, engine serial number, flight/engine cycles and
creep information

After you enter the new values, select the write button.

The new parameters values will be updated in the monitor and the Current Value
column will be refreshed. Verify the current values are appropriately refreshed
before closing.
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View/Reset creep faults:

Click “View Creep Fault” to display current creep faults:

A list of active creep faults is displayed, including creep fault type and date and time
of occurence. To reset creep faults, click “Reset Creep Fault”.

Creep faults will be cleared in the monitor and creep fault list refreshed.

Click “Reset Prev Exceed” to reset Exceed messages from the crew-alerting
system (CAS). 
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3.9.3 View/Change Monitor Parameters for other applications

For other applications, the function enables the user to view the configuration
Version and when applicable clear and enter the engine serial number information. 

After you have entered the new value, select the "Write: button.

The new value will be written to the monitor and the Current Value column will be
updated.

To clear the Engine serial number stored in the FAST Box click "Proceed"
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3.10 Expert Command Mode Function

Accessing:

The Expert Command Mode function can be used to communicate with the monitor
by sending commands and displaying monitor responses

The user can select commonly used expert commands from a menu

When the Send button is selected
- The monitor responses are displayed 
- The session can be saved and printed
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Selecting the Advanced button requires entering a password for advanced
troubleshooting and permits typing any command. To obtain the password, contact
P&WC Customer First center.

The program then permits writing to the actual command prior to clicking the Send
button
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3.11 Get Micro Server Logs

The Get Micro Server Logs function is used for advanced troubleshooting when
instructed by P&WC personnel.

The function will automatically download all micro server logs to the users local
computer.

To transfer the data to PWC for analysis, the user must perform the Sync To
Webserver  function.

3.12 FAST Factory Reset

The FAST Factory Reset function is to be used for advanced troubleshooting when
instructed to do so by P&WC personnel.

The FAST Factory Reset will delete all non-transmitted data from your FAST box
and configure it to the latest configuration. Once this function is started, it cannot
be cancelled.

Selecting the FAST Factory Reset button requires entering a password. To obtain
the password, contact P&WC Customer First center.

After the password is entered, the program will determine if the configuration files for
the FAST box are located on the local computer. If the files are not available, please
perform the Sync To Webserver function.

After the password is entered and the configuration files are available on the local
laptop, the program will begin the reset function. During the reset it is not possible to
navigate, or from the Factory Reset Screen.

50
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At the end of the function, the program will reconfigure the box with the configuration
files located on the local computer.

3.13 Delete Non-Transmitted Logs

The Delete Non-Transmitted Logs function may be used when instructed to do so
by P&WC personnel. The function is used to erase all non-transmitted data in the
FAST box. Once this function is started, it cannot be cancelled.

Selecting the Delete Non-Transmitted function requires entering a password. To
obtain the password, contact P&WC Customer First center.

After the password is entered, the program will begin the erase function. During the
erase function it is not possible to navigate from the Delete Non-Transmitted Logs
screen.
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3.14 Wi-Fi Configuration

The FAST monitor revision E or higher is capable to offload data via Wi-Fi
connection. The compatibility can be verified by using the Monitor Status  function
to confirm that the MSSIM version (PW_VER) is 3.0 or higher.

For FAST to automatically connect to a Wi-Fi network, it must first be configured
using MonitorTM and a pc connected via the GSE cable.

Accessing:

If the FAST is not compatible with Wi-Fi, the user will see the following error
message.

25

Draf
t



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

47Communicating with the Monitor

© 2019 Pratt & Whitney Canada Inc

Once connected the user will see a screen similar to the one below. 
 
Already configured Wi-Fi networks are displayed with signal strength, if in range. If
the FAST is already connected to a network, "Connected" will be displayed next to
the appropriate configured network SSID. The user can remove (Forget) individual
or all configured networks. 

The passwords for already configured network SSIDs are not stored on the local
computer. The user may enter a new password. Only when entering a password,
the user can select the icon to view what is being entered. Only the FAST stores the
network passwords.  It is recommended that Forget All networks is done prior to
FAST removal. If the FAST is returned to P&WC, the network passwords could be
accessed by P&WC personnel.

Available networks are displayed with signal strength. Only available Wi-Fi networks
that do not contain special characters or spaces will be available to connect.The
user can enter a password for any available networks.

The user can manually enter a Network SSID, security and password. The user can
enter one network at a time. SSID cannot contain special characters or spaces.
Only networks with no security, WPA or WPA2 security are compatible.

In all cases when the Edit button is selected, the user may cancel.

3.15 WI-FI Configuration for MFAST

For MFAST to automatically connect to a Wi-Fi network, it must first be configured
using MonitorTM and a pc connected via the USB (RNDIS/Ethernet Gadget) cable.

Accessing:
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Once connected the user will see a screen similar to the one below. 
 
Already configured Wi-Fi networks are displayed with signal strength, if in range. If
the MFAST is already connected to a network, "Connected" will be displayed next to
the appropriate configured network SSID. The user can remove (Forget) individual
or all configured networks. 

The passwords for already configured network SSIDs are not stored on the local
computer. The user may enter a new password. Only when entering a password,
the user can select the icon to view what is being entered. Only the FAST stores the
network passwords.  It is recommended that Forget All networks is done prior to
FAST removal. If the FAST is returned to P&WC, the network passwords could be
accessed by P&WC personnel.

Available networks are displayed with signal strength. Only available Wi-Fi networks
that do not contain special characters or spaces will be available to connect.The
user can enter a password for any available networks.

The user can manually enter a Network SSID, security and password. The user can
enter one network at a time. SSID cannot contain special characters or spaces.
Only networks with no security, WPA or WPA2 security are compatible.

In all cases when the Edit button is selected, the user may cancel.

Draf
t



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

Communicating with Webserver

Part

IV
Draf

t



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

50 MonitorTm Help Manual

© 2019 Pratt & Whitney Canada Inc

4 Communicating with Webserver

4.1 Sync to Webserver Function

Accessing:

   

This function synchronizes the computer with the P&WC Webserver
- uploads log files to Webserver
- downloads configuration files to the pc
- downloads updates of the MonitorTm program

The user must manually enter the related monitor serial numbers.

The program will then transfer 
- configuration files from the Webserver to the computer
- log files from the computer to the Webserver 
- MonitorTm program updates from the Webserver to the computer if available
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5 Analyzing Data

5.1 Convert Log Function

Accessing:

5.1.1 General convert log function

Prior to analyzing data locally in GBSLite , logs must be converted using the
convert log function

1. The user must select the Input Folder Selection using the Browse button. The log
files in the Input Folder will be listed. The user must select the log files to convert
using check box next to the filename. 

2. A unique Output Folder is proposed automatically. The user can modify the
Output
Folder location and name.

57
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    *Please note that the Output Folder most always be different then the Input
Folder.

3. The column header check box can be used to select all log files.

4. If required, Full Flight Data Mode option is used for troubleshooting and full flight
data analysis.

5. Click the Start button to begin conversion of selected files

6. When conversion has begun, conversion progress and status will be displayed.

7. The icon near the browse button can be clicked to open a Windows Explorer
window of the selected path.

8. To exit the convert log function, press close.

5.1.2 Q200/Q300/ATR42/ATR72 convert log function

For the Q400/Q300/ATR42/ATR72 application, the program converts only  zip files
that regroups the complete set of 4 data files per sequence as listed in the example
below:

- 4ff8f1b2-01of04-fast-q300_eec_1-*.dtu
- 4ff8f1b2-02of04-fast-q300_foqa-*.dtu
- 4ff8f1b2-03of04-fast-q300_eec_2-*.dtu
- 4ff8f1b2-04of04-fast-sys-*.dtu

Any incomplete zip file can only be converted in Full Flight Data Mode for
troubleshooting analysis.
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5.1.3 Q400 convert log function

For the Q400 application, the program converts only zip files that regroups the
complete set of data files per sequence as listed in the examples below:

Set of 7 files – Full Flight and EMU data (Phase 2 with propeller monitoring):
· 53b22546-01of07-fast-q400_cds-*.dtu

· 53B22546-02of07-FAST-SYS-*.dtu

· 53b22546-03of07-fast-q400_foqa-*.dtu

· 53b22546-04of07-fast-q400_emu-*.dtu

· 53b22546-05of07-fast-q400_eec_1-*.dtu

· 53b22546-06of07-fast-q400_eec_2-*.dtu

· 53b22546-07of07-fast-q400_uib-*.dtu

Set of 6 files – Full Flight and EMU data (Phase 2):
· 53b22546-01of06-fast-q400_cds-*.dtu

· 53B22546-02of06-FAST-SYS-*.dtu

· 53b22546-03of06-fast-q400_foqa-*.dtu

· 53b22546-04of06-fast-q400_emu-*.dtu

· 53b22546-05of06-fast-q400_eec_1-*.dtu

· 53b22546-06of06-fast-q400_eec_2-*.dtu

Set of 4 files – Full Flight and EMU data (Phase 1):
· 53b22546-01of04-fast-q400_cds-*.dtu

· 53B22546-02of04-FAST-SYS-*.dtu

· 53b22546-03of04-fast-q400_foqa-*.dtu

· 53b22546-04of04-fast-q400_emu-*.dtu

Set of 3 files – Full Flight Only
· 53b93856-01of03-fast-q400_foqa-*.dtu

· 53B93856-02of03-FAST-SYS-*.dtu

· 53b93856-03of03-fast-q400_cds-*.dtu

Set of 2 files – EMU data Only:
· 53C26DC8-01of02-FAST-SYS-*.dtu

· 53c26dc8-02of02-fast-q400_emu-*.dtu

Any incomplete Q400 zip file can only be converted in Full Flight Data Mode for
troubleshooting analysis.

5.1.4 AW139 convert log function

For the AW139 application, the program converts only zip files that regroups the
complete set of data files per sequence as listed in the example below:

Set of 5 files – Full Flight with APAC:
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· 53C26DC8-01of05-FAST-SYS-*.dtu

· 53c26dc8-02of05-fast-aw139_foqa-*.dtu

· 53c26dc8-03of05-fast-aw139_eec_1-*.dtu

· 53c26dc8-04of05-fast-aw139_eec_2-*.dtu

· 53c26dc8-05of05-fast-etm_aw139-*.dtu

Set of 2 files – Full Flight:
· 53C26DC8-01of02-FAST-SYS-*.dtu

· 53c26dc8-02of02-fast-aw139_foqa-*.dtu

Any incomplete AW139 zip file can only be converted in Full Flight Data Mode for
troubleshooting analysis.

5.1.5 680A convert log function

For the 680A application, the program converts only zip files that regroups the
complete set of data files per sequence as listed in the example below:

Set of 5 files – Full Flight and EDU data:
· 53C26DC8-01of05-FAST-SYS-*.dtu

· 53c26dc8-02of05-fast-680a_eec_1-*.dtu

· 53c26dc8-03of05-fast-680a_eec_2-*.dtu

· 53c26dc8-04of05-fast-680a_edu_1*.dtu

· 53c26dc8-05of05-fast-680a_edu_2*.dtu

Any incomplete 680a zip file can only be converted in Full Flight Data Mode for
troubleshooting analysis.

5.1.6 Caravan convert log function

For the Cessna Caravan application, the program can convert:

- An ETM file which contains engine exceedance, event, trend and creep
information.
- A Full Flight data file (*G1000_FFD*) which contains full flight data of engine
parameters.
The ETM file must be converted into GBS standard file for analysis in GBSLite, as
listed in the example below:
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The Full Flight data files (*G1000_FFD*) can be converted in Full Flight Data Mode
to analyze full flight data in GBSLite.

5.1.7 EPEC Convert Log function

For the EPECS application, the program converts DTU* files in Full Flight Data
Mode for analysis. 

Note* :This function is in development

5.2 View Data in GBSLite Function

Accessing:

Opens Live Data  recordings and Converted Log Data  for analysis in GBSLite by
selecting the desired folder. 

Please refer to GBSLite Help Manual for additional information
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The user must select the folder where the data has been converted. This can be
under Liverdata, Logdata or any other location.

The data will be displayed in GBSLite
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6 Monitor TM Auto-Update

6.1 Monitor TM Auto-Update

Accessing:

If an update exists, the program will indicate that an update is available and will need
to follow the instructions

If no update exists, the program will indicate that your program is up to date.Draf
t
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7 Additional Information

7.1 Changing MonitorTm preferences

Accessing:

The Preferences function is available to customize the retrieve log files settings

Tag Data Transmitted: 
When checked, the files retrieved by the program will be tagged as transmitted
- It is the user's responsibility to send the data to the Web via the Sync to
Webserver Function .

When unchecked, the files retrieved will be transmitted to the Web via GSM at next
available transmission.

Log Download Time:
In the Retrieve Log Files Function , when the download time to retrieve log files is
below this value, the program will retrieve all log files without requiring user selection

50
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7.2 Printing

Accessing:

    

Print and Print Preview can be used whenever a function is being performed

Print Setup allows the user to change the printing options such as orientation and
paper size

7.3 Troubleshooting

7.3.1 View Session Log Function

Accessing:

All actions performed while using MonitorTM are recorded automatically in a session
log file for troubleshooting purposes.

Session logs can be displayed by filtering the 4 different categories available and
can be printed under File Menu/Print.
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7.3.2 View Saved Monitor Status Function

Accessing:

View previously saved Monitor Status function  sessions

Please refer to the Monitor Status Function  section for a description of the
possible status messages and recommended actions

25
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7.3.3 Communication Troubleshooting

Please follow the steps listed below to troubleshoot problems you
may have while communicating with the Monitor

· Cycle Monitor Aircraft Power / Monitor power

Ensure lights are seen on the monitor

Perform Communication Settings Function (Auto-Detection )

Message: FAST Successfully Connected

oRetry the original function.  If problem persists, contact cfirst@pwc.ca

Message: Connection not successful on any available ports

oProblem Not Yet Solved.  Proceed to next Step

· Ensure cable is inserted properly to the monitor J3 connector and to the PC
Perform Communication Settings Function (Auto-Detection )

Message: FAST Successfully Connected

oRetry the original function.  If problem persists, contact cfirst@pwc.ca

Message: Connection not successful on any available ports

oProblem Not Yet Solved.  Proceed to next Step

· Disconnect Cable from the PC
Perform Communication Settings Function (Manual Detection )

Message: FAST Successfully Connected

oRetry the original function.  If problem persists, contact cfirst@pwc.ca

Message: Connection not successful on any available ports

oProblem Not Yet Solved. Contact cfirst@pwc.ca

If problem persists, contact Customer service at Pratt & Whitney Canada
cfirst@pwc.ca

7.3.4 GBSlite Analysis Troubleshooting

Please follow the solution listed below to troubleshoot problems you
may have while performing GBSlite analysis

Error Message Description Solution
There is no fault
file in this
directory
Please select a

There is no viewable data
in the selected folder

Make sure you are opening
the correct folder.  Refer to 
View Data in GBSLite
Function

34
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different directory

Directory is empty.
Please select a
different directory

System error.
Missing GBSlite
configuration files.
Program will
terminate

GBSlite is installed
without MonitorTm.

Install MonitorTm.  Refer to 
Program Installation

A GBSlite program is
already running

Tried to start GBSlite
program while already
running.

Click GBSlite program button
on the Windows taskbar

7.3.5 Sync to Webserver Troubleshooting

If you see the error message below, your system may not be able to communicate
with the MonitorTM servers.

Confirm that you can access the internet.

You may need to add the site "dphmsftp.pwc.ca " (without quotes) to your firewall’s
safe list.

In addition the proxy parameters can be edited to include the following:

Adress: dphmsftp.pwc.ca
Port: 22

Contact your IT department for additional help.

7.4 FAST USB GSE Cable Driver Installation

Driver installation can be done before or after inserting the USB cable into your PC’s
USB port.

1. Prior to hardware installation admin rights on the PC will be required.

2. With MonitorTM installed, open Windows explorer to “Driveletter:\GBS-PWC
\bin\Monitor\STARTUP\Driver”.
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3. Depending on your operating system, double-click dpinst32.exe for 32-bit
version of Windows or dpinst64.exe for 64-bit version of Windows. 

Note: If you are using 32-bit operating system, dpinst64.exe cannot be opened.

4. Follow the onscreen instructions. Select the “Finish” button to complete the
driver installation.

7.5 MFAST USB GSE Cable Driver Installation

Driver installation is done after inserting the USB cable into your PC’s USB port.

1. Prior to hardware installation admin rights on the PC will be required.

2. Power the MFAST and wait 1 Minute 

Note: The MFAST USB interface presents a network interface to the host PC

3. Depending on your operating system, please follow the below instructions

For Windows 7 , the OS will automatically search for the RNDIS driver and will
display the following message:
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For Windows 8 and above :

- Go to Device Manager
- Find the RNDIS/Ethernet Gadget under "Other Devices"

- Once here Right click on the RNDIS/ ETHERNET Gadget  and select Update Driver
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- Choose "Browse my computer for driver software"

- Select "Let me pick from a list of device drivers on my computer" and click
next.
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- Once prompt select "Network Adapters"

- In the Select Network Adapter window, select Microsoft Corporation 
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- Select Remote NDIS compatible Device and click next

4. Driver is now installed and ready to be use .
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